
خلق یک متن پلاستیکی براق در فتوشاپ 

در این آموزش ساده و کوتاه یاد خواهید گرفت چگونه یک متن با افکت پلاستیکی براق و صیقلی در فتوشاپ خلق 
کنید. با ترکیب سه layer style به این افکت زیبا دست پیدا خواهید کرد. همچنین blending mode های 

مختلف و کابردهای تاثیرگذار آنها به دست یابی به این افکت کمک شایانی می کند. 

پیش نمایش تصویر نهایی

مرحله1
یک فایل جدید با تنظیمات زیر در فتوشاپ ایجاد کنید. 

مرحله2
ابزار )Type (T را انتخاب کنید و در قسمت نوار تنظیمات Arial Black و pt 325 و smooth را انتخاب کنید. 

سپس کلمه “psd” را در قسمت پایین صفحه تایپ کنید. 
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مرحله3
ابزار )Movel (V را انتخاب کنید. سپس در پنل لایه ها واقع در سمت چپ پنجره فتوشاپ، روی لایه 

background کلیک کنید تا لایه انتخاب شود. حالا کلید shift را فشار داده و روی لایه Type کلیک کنید. 
وقتی بیش از یک لایه انتخاب شده باشد، دکمه های Alignment یا تنظیمات چیدمان در قسمت نوار تنظیمات 
فعال می شود. سپس روی دکمه های Vertical Centers و Horizontal Centers کلیک کنید تا لایه متن 

در وسط صفحه قرار بگیرد. 

مرحله4
یک لایه جدید اضافه کنید، برای این کار روی آیکون Create a new layer که در قسمت پایین پنل لایه ها قرار 
دارد کلیک کنید، سپس آن را با رنگ سفید رنگ آمیزی کنید. هر د لایه جدید را با تکنیک کلیک و shift انتخاب 

کنید. سپس به مسیر Menu > Layer > Merge Layers بروید تا دو لایه در یک لایه با هم ادغام شوند. 
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مرحله5
برای ایجاد یک افکت متن پلاستیکی براق به یک فونت bold یا ضخیم با گوشه های گرد نیاز داریم. چون گوشه 
های گرد نور بیشتری نسبت به گوشه های تیز و زاویه دار دریافت می کنند. اما لبه های Arial Black زاویه دار 
است. بنابراین با کمک یک تکنیک ساده و سریع زاویه ها را گرد می کنیم. ابتدا روی لایه “psd” کلیک کرده و به 

مسیر )px 8 :Filters > Blur > Gaussian Blur (Radius بروید. 

مرحله6
سپس روی همان لایه به مسیر Image > Adjustments > Levels بروید. در قسمت Input Levels، لغزنده 

سمت چپ )Shadow( را به سمت راست و لغزنده سمت راست )Highlight( را به سمت چپ بکشید. این کار 
قسمت خاکستری رنگ ماتی که با اعمال Gaussian Blur تولید شده بود را پاک و یا آنها را کم رنگ تر می کند و 

آن قسمت را به یک رنگ سیاه یک دست تغییر می دهد. به همین دلیل حالا لبه های زاویه دار گرد می شوند. 

مرحله7
ابزار )Magic Wand (W را انتخاب کرده و روی قسمت سیاه رنگ لایه “psd” کلیک کنید تا متن سیاه رنگ 

انتخاب شود. در حالی که انتخاب فعال است یک لایه جدید بالای لایه “psd” اضافه کنید. سپس انتخاب را با رنگ 
 Ctrl + تغییر دهید. با فشار دادن کلیدهای ”base style“ خاکستری 50 درصد رنگ آمیزی کنید و نام لایه را به

D از حالت انتخاب خارج شوید. 
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مرحله8
شما می توانید لایه “psd” را پاک کنید چون دیگر به آن نیاز نداریم. روی لایه Background دوبار کلیک کنید 
تا این لایه به یک لایه معمولی )Layer 0( تبدیل شود. حالا روی متن Layer 0 دوبار کلیک کنید و نام آن را به 

“gradient bg” تغییر دهید. سپس روی لایه “gradient bg” دوبار کلیک کنید تا پنجره Layer Style باز 
شود. ابتدا در قسمت Gradient Overlay یک گرادیانت شعاعی )Radial gradient( با تنظیمات زیر ایجاد 

کنید. 

مرحله9
 Gradient با تنظیمات زیر اعمال کنید. این کار باعث ایجاد یک بافت نوسان دار از Inner Glow سپس یک

Overlay می شود. 

مرحله10
لایه “base style” را انتخاب کنید. روی آن دوبر کلیک کنید تا پنجره Layer Style باز شود. ابتدا در قسمت 

Blending Option، مقدار Fill Opacity را به 0 تغییر دهید. این باعث می شود حالت پلاستیکی شفاف شود. 
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مرحله11
سپس برای قسمت Bevel and Emboss تنظمیاتی که در تصویر زیر مشاهده می کنید را به کار ببرید. در 

قسمت Shading، برای Highlight Mode گزینه Linear Dodge را انتخاب کنید چون های لایت های 
قوی تری نسبت به مود Screen دارد. همچنین برای Shadow Mode از Color Dodge استفاده کنید. در 

زیر Bevel and Emboss گزینه Contour of Bevel and Emboss قرار دارد، که اساسا لبه ها یا شانه های 
Bevel را تعریف می کند. روی Contour کلیک کرده و Gaussian را انتخاب کنید. 

مرحله12

تنظیمات Inner Glow. توجه می کنید که مود Darken برای ایجاد یک ترکیب رنگ تیره تر استفاده می شود. 
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مرحله13
تنظیمات Outer Glow. مود را در حالت Darker Color قرار داده تا یک ترکیب رنگ تیره تر ایجاد شود. 

مرحله14
تنظیمات Inner Shadow: در اینجا Blend Mode در حالت Multiply قرار می دهیم تا یک حاشیه خارجی 

خیلی تیره تر ایجاد شود. 
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مرحله15
تنظیمات Drop Shadow: در اینجا Drop Shadow سایه ایجاد نمی کند. اما برای ایجاد نور روشن تری که از 

لبه های یک شئ شفاف عبور می کند استفاده می شود. 

مرحله16
تنظیمات Satin برای ایجاد بازتاب سطح براق. مود Color Dodge به ایجاد این افکت کمک می کند. در قسمت 
contour برای بیشتر بازتاب ها از Ring – Double استفاده کنید اما برای اینکه این تغییر ظریف تر و ملایم تر 

باشد مقدار Opacity را به 15 درصد تغییر دهید. 
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مرحله17

حالا حلت پلاستیکی متن کامل شد.

مرحله18
روی لایه “base style” کلیک راست کرده و گزینه Duplicate Layer را انتخاب کنید. نام لایه کپی را 

“secondary highlights” بگذارید. روی لایه دوبار کلیک کنید تا پنجره Layer Style باز شود سپس همه 
آیتم های درون Bevel and Emboss و Satin را غیر فعال کنید. تنظیمات را با تصویر زیر تطبیق دهید. 
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مرحله19
حالا روی Satin Style کلیک کرده و تنظیمات زیر را اعمال کنید. Contour در حالت Ring – Double قرار 

دارد، اما در اینجا مقدار opacity را کمی بیشتر کنید. 

مرحله20
تا اینجا به نتیجه ای شبیه تصویر زیر دست پیدا کرده اید. 
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مرحله21

لایه “secondary highlights” را Duplicate کرده و نام لایه کپی را به “primary highlights” تغییر 
دهید. روی لایه دوبار کلیک کرده تا پنجره Layer Style باز شود. تنظیمات Bevel and Emboss را مطابق 

تصویر زیر اعمال کنید. 

مرحله22
تنظیمات Drop Shadow: این کار برای افزایش عبور نور از لبه ها است. 
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مرحله23
تا اینجا به نتیجه ای که در تصویر زیر مشاهده می کنید دست پیدا خواهید کرد. 

مرحله24
 primary“ حالا سبک پلاستیکی کامل شده است. ولی می خواهیم تغییرات دیگری نیز اعمال کنیم. لایه

 copy merge را فشار دهید تا یک لایه Ctrl + Shift + Alt + E را انتخاب کرده و کلیدهای ”highlights
شده روی آن ایجاد کنید. نام آن را “upper reflections” بگذارید. لایه را Duplicate کرده و نام آن را 

 opacity .بگذارید ”base layer“ را زیر لایه ”surface reflections“ بگذارید. لایه ”surface reflections“
لایه “surface reflections” را به 20 درصد کاهش دهید. حالا لایه “upper reflections” را انتخاب کرده، 
opacity آن را به 10 درصد و blend mode را به Multiply تغییر دهید. در زیر نتیجه را مشاهده می کنید.
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مرحله25
یک لایه جدید اضافه کرده و نام آن را “glow” بگذارید و آن را روی لایه “upper reflections” قرار دهید سپس 

با یک براش نرم سفید رنگ، نقاط براقی در قسمت بالای منطقه های لایت شده اضافه کنید. opacity را به 50 
درصد تغییر دهید. اگر در حالی که با ابزار براش کار می کنید کلید Alt را نگه دارید، ابزار براش به طور موقت به 

ابزار قطره چکان یا Eyedroppe تبدیل می شود. با فعال شدن ابزار Eyedropper یک رنگ آبی روشن از قسمت 
های های لایت انتخاب کرده و سپس تعدادی نقطه آبی روشن نقاشی کنید. opacity لایه “glow” را به 50 درصد 

کاهش دهید. در اینجا نتیجه کار را پس از اتمام کار مشاهده می کنید. 

مرحله26
یک لایه Curve Adjustment اضافه کنید. برای این کار روی دکمه چهارم از سمت چپ پنل لایه ها کلیک 

کنید. در پنجره Curve یک منحنی S شکل ایجاد کنید تا کنتراست به طور کلی تنظیم شود. 
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مرحله27
 Duplicate را ”glow“ را به 20 درصد کاهش دهید. لایه opacity را انتخاب کرده و مقدار ”glow“ حالا لایه

کرده و نام آن را به glow 2 تغییر دهید. لایه را به بالای پنل لایه ها برده و opacity را به 40 درصد کاهش دهید. 
حالا افکت پلاستیکی شفاف و براق کامل شده است. 

نتیجه نهایی
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مشاهده آموزش های دیگر سایت

www.persianGFX.com    منبع پرشین جی اف ایکس        

http://persiangfx.com/fa/tutorials/photoshop/text-effects/


مجموعه پیش رو یکی از کامل ترین و برترین مجموعه های آموزشی در زمینه فتوشاپ می باشد که  
ویژگی های خاص این مجموعه آن را از سایر مجموعه های مشابه متمایز نموده، از جمله این ویژگی ها 
قرار گیری هفت دوره آموزشی Adobe Photoshop CS4 ارائه شده توسط برترین اساتید جهان، به 

 Mark  همراه مجموعه ای از نکات و ترفند های کار با فتوشاپ در قالب 101 پروژه آموزشی توسط آقای
Monciardini مدرس مجموعه Photoshop Top Secret، همچنین مجموعه ی بی نظیر و نفیس 
Photoshop Top Secret با زبان و محیط 100درصد فارسی )با کمترین دستکاری(، در قالب 6 دی 

وی دی است، که در بسته بندی اختصاصی تقدیم شما می گردد.

محتویات این مجموعه بی نظیر به اجمال عبارتند از:
- مجموعه آموزشی Photoshop Top Secret به زبان فارسی با محیط کاملًا فارسی

Photo Tips 101 Mark›s مجموعه آموزشی -
- مجموعه هفت دوره آموزشی Adobe Photoshop CS4 شامل:

For Beginners Photoshop CS4 دوره آموزشی -  
Power Session Adobe Photoshop CS4 دوره آموزشی -  

Selections & Masks Adobe Photoshop CS4 دوره آموزشی -  
Mastering Layers in Photoshop CS4 دوره آموزشی -  
Design Effects With Photoshop CS4 دوره آموزشی -  
Beauty and Portrait Retouching Kit دوره آموزشی -  

Integration 4 Creative Suite دوره آموزشی -  

توضیحات بیشتر...

http://persiangfx.com/fa/other/products/persian-photoshop-top-secret/
http://persiangfx.com/fa/other/products/persian-photoshop-top-secret/


مجموعه فوق که در قالب دو دی وی دی آماده شده شامل مجموعه ای از ابزار و وسایل مورد نیاز طراحان 
و گرافیست ها و کاربران فتوشاپ است که شامل گلچینی از بهترین اکشن ها، براش ها، تصاویر پترن، شیپ 

ها، استایل ها و گرادینت است که همگی در قالب جعبه ابزاری گردآوری شده اند.
در این مجموعه سعی شده غیر از موارد فوق ابزار دیگری مانند بافت های بسیار زیبا، تصاویر اسلیمی شامل 

فریم های آماده بهمراه خوشنویسی های زیبا با فرمت وکتور و نیز مجموعه کاربردی از تصاویر لایه باز و 
کلیپ آرت، در کنار جعبه ابزار فتوشاپ قرار گیرد که در ادامه کلیه ابزار و محتویات به اختصار توضیح داده 

شده است

محتویات این بسته ی به اجمال عبارتند از:
Extended ME Adobe Photoshop CS5 نرم افزار -

- دوره مقدماتی آموزش فتوشاپ به زبان فارسی
CS5 دوره آموزشی لیندا آشنایی با پنج ابزار جدید طراحی در فتوشاپ -

 Brush, Action, Pattern, Texture, Style , جعبه ابزاری کم نظیر شامل منتخبی از زیبا ترین -
Shape

- مجموعه تصاویر زیبای لایه باز و کلیپ آرت های دوست داشتنی
EPS مجموعه تصاویر زیبای وکتور شامل فریم های آماده به همراه خوشنویسی های آماده زیبا با فرمت -

- مجموعه مجلات Photoshop Creative و دیگر مجلات گرافیکی
- مجموعه نادری از فونت های زیبای عربی

- مجموعه کلیه فونت های فارسی
- گلچینی از فونت های انگلیسی

توضیحات بیشتر...

http://persiangfx.com/fa/other/products/photoshop-professional-tools-box-02/
http://persiangfx.com/fa/other/products/photoshop-professional-tools-box-02/


مجموعه فوق شامل محبوب ترین نرم افزار های طراحی و گرافیک شرکت ادوبی بوده که ویژگی متمایز این 
مجموعه پشتیبانی نرم افزار های فوق از زبان فارسی است. که همگی تحت عنوان Standard Design یا نرم 
افزار های استاندارد شرکت ادوبی جهت انجام طراحی عرضه شده که نسخه اصلی Standard Design شامل 

نرم افزار های ادوبی به زبان انگلیسی بوده که در اینجا شما همان نرم افزار ها را با پشتیبانی از زبان فارسی 
دریافت می کنید، به همراه مجموعه فوق مجموعه فیلم های آموزشی شامل ویژگی های جدید این نرم افزار ها 
که توسط موسسه لیندا تهیه شده نیز وجود دارد. بسته فوق شامل دو دی وی دی بوده و در بسته بندی شکیل 

تقدیم به خریداران محترم سایت می شود.

محتویات این بسته ی به اجمال عبارتند از:
Extended ME Adobe Photoshop CS5 نرم افزار -

ME Adobe Illustrator CS5 نرم افزار -
ME Adobe InDesign CS5 نرم افزار -

ME Adobe DreamWeaver CS5 نرم افزار -
ME 9 Adobe Acrobat Pro نرم افزار -
- مجموعه فیلم های آموزشی Lynda شامل:

New Features Photoshop CS5 مجموعه آموزشی _  
New Features Illustrator CS5 مجموعه آموزشی _  
New Features InDesign CS5 مجموعه آموزشی _  

New Features Dreamweaver CS5 مجموعه آموزشی _  
- مجموعه نادری از فونت های زیبای عربی

- مجموعه کلیه فونت های فارسی
- گلچینی از فونت های انگلیسی

توضیحات بیشتر...

http://persiangfx.com/fa/other/products/adobe-crative-suite-5-standard-design-me/
http://persiangfx.com/fa/other/products/adobe-crative-suite-5-standard-design-me/


این پکیج شامل تمامی مطالب و موضوعاتی است که در طول سه سال گذشته بر روی سایت گذاشته شده و پس 
از جمع آوری و دسته بندی حرفه ای هم اکنون در اختیار دوست داران و علاقه مندان گرافیک و گرافیست ها قرار 

گرفته است که در ادامه به اختصار محتویات پکیج های فوق را می توانید مشاهده نمایید و اساسا این مجموعه 
شامل موارد فوق می باشد:

 
- بیش از 300 آموزش حرفه ای و مقدماتی نرم افزار فتوشاپ با فرمت پی دی اف به همراه تصاویر و فایل های 

ضمیمه
- بیش از 190 آموزش حرفه ای و مقدماتی نرم افزار ایلوستریتور با فرمت پی دی اف به همراه تصاویر و فایل های 

ضمیمه
- دوره کامل آموزش مقدماتی نرم افزار ایندیزاین بهمراه آموزش های دوره پیشرفته

- دوره کامل آموزش مقدماتی نرم افزار فلش به همراه آموزش های متفرقه
- بیش از 200 مقاله کاربردی با موضوعات مختلف و کاربردی گرافیک با فرمت پی دی اف

- ابزار طراحی شامل لوگو، آیکون، تصاویر وکتور، اسلیمی، کلیپ آرت و...
- تصاویر و آثار هنری هنرمندان و عکاسان جهت گرفتن ایده و افزایش مهارت های طراحی

- دسته بندی حرفه ای مطالب و ابزار کاربردی مطابق با دسته بندی سایت
- بسته بندی زیبا و شکیل با بالاترین کیفیت ممکن

توضیحات بیشتر....

مشاهده سایر محصولات گرافیکی

http://persiangfx.com/fa/other/monthly/graphic-and-design-tools-monthly-archive/
http://persiangfx.com/fa/other/monthly/graphic-and-design-tools-monthly-archive/
http://persiangfx.com/fa/other/products/

